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Introduction

Welcome to the Creo® Color Server (Spire CX260) for the Xerox® DocuColor 242/
252/260 printer/copier software release notes. These release notes provide the 
latest information about the Spire CX260. For more information about each feature, 
refer to the Creo Color Server 2.0 for the Xerox DocuColor 242/252/260 Printer/Copier 
User Guide. 

What Is in These Release Notes
The release notes include the following sections:

Terminology—outlines the Spire CX260 terminology used in these release notes.

Software Kit Contents—describes the contents of the Spire CX260 software kit.

Installing the Spire CX260—describes the installation procedure for the Basic and 
Control Station Upgrade Kit configurations.

Key Features—describes the main menu commands, options, windows, and dialog 
boxes of the Spire CX260.

Tips—provides tips for users of the Spire CX260.

Limitations— lists the limitations for this Spire CX260 release.
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Terminology

The Spire CX260 is available in four configurations:

Table 1: Terminology

Configuration Description

Spire CX260 (“Basic 
configuration”)

Spire CX260 mounted on the Xerox DocuColor 
242/252/260 printer/copier

Spire CX260 with Control 
Station Upgrade Kit 
(“Control Station 
configuration”)

Upgrade kit that includes the Spire CX260 
mounted on a stand, monitor, keyboard, mouse, 
and DVD-ROM. A dongle is required for this 
configuration.

Note: The Spire CX260 is a prerequisite for this 
configuration.

Spire CX260 with 
Professional Upgrade Kit 
(“Pro Basic configuration”)

Upgrade kit that includes the GretagMacbeth® 
Eye-One® spectrophotometer and advanced 
software features. A dongle is required for this 
configuration.

Note: The Spire CX260 is a prerequisite for this 
configuration.

Spire CX260 with 
Professional Control Station 
Upgrade Kit (“Pro Control 
Station configuration”)

Upgrade kit that includes the Spire CX260 
mounted on a stand, monitor, keyboard, mouse, 
DVD-ROM, GretagMacbeth® Eye-One® 
spectrophotometer and advanced software 
features. A dongle is required for this configuration.

Note: The Spire CX260 and Control Station upgrade 
kit are prerequisites for this configuration.
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Software Kit Contents

The software kit contains the following CDs/DVDs:

• DVD #2—Spire Application software: contains the Spire CX260 multilingual 
application software (setup, PPDs, printer drivers, and utilities).

• CD #3—Spire Documentation and Utilities: contains the client software utilities, 
the Creo Color Server 2.0 for Xerox DocuColor 242/252/260 Printer-Copier 
Technical Manual, User Guide, and Release Notes in PDF format.

This CD-ROM has sections for both Macintosh® and PC, so it can be used on 
any client computer with a CD-ROM drive. The documentation can be printed 
on any printer.

Note:  CD #1—XP Professional OS installation is not provided with this product. The 
Spire CX260 has a built in OS recovery mechanism.
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Installing the Spire CX260

This section describes the following installation procedures:

• Spire CX260 Basic configuration

• Spire CX260 with Control Station Upgrade Kit

Installing the Spire CX260
1. If you do not have the Remote Desktop Connection utility installed on your 

computer, install it from the Utilities folder on the Spire CX260 CD #2, or 
download it via the Spire CX260 Web Center:

a. On your computer, open the Spire CX260 Web Center home page: http://
<CX260 Server name or IP address> (the server name and IP address 
appear on the Spire CX260 test page).

b. Click the Downloads tab, and then click Utilities Folder under PC 
Downloads.

http://<CX250 Server name or IP address>
http://<CX250 Server name or IP address>


 

Installing the Spire CX260 5

c. Click RemoteDesktop.exe and Run to install the Remote Desktop 
Connection application.

2. Select Start > Programs > Accessories > Communications > Remote Desktop 
Connection. 

3. Select the General tab and enter the following information:

a. The name of the Spire CX260 to which you want to connect

Note: You can find the Spire CX260 name on the test page that automatically 
prints when the Xerox DocuColor 242/252/260 printer/copier is turned on, and 
on the sticker on the Spire CX260.
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b. The Spire local user name; the default is operator.

c. The Spire local password; the default is spire.

4. Select the Local Resources tab. In the Local devices area, select the Disk drives 
check box.

5. Click Connect.

The Log On to Windows dialog box appears on the Spire CX260.

6. Enter the User Name and Password, and click Connect.

7. Via the remote desktop, go to Start > Settings > Control Panel > Add or 
Remove Programs to remove the current Spire CX260 software.

8. Restart the Spire color server. 

9. Repeat steps 2 and 5 (you do not need to repeat steps 3 and 4 because the 
connection parameters are saved).

10. Insert CD #2 (Spire application software) into your CD-ROM or DVD-ROM 
drive.

11. On the Spire CX260 desktop, double-click My Computer. 

12. Under Devices with Removable Storage, select the CD/DVD-ROM drive. 
This is your local CD/DVD-ROM drive that is published on the Spire CX260

13. Double-click <Drive>\CX260\Setup.exe and follow the installation steps in the 
InstallShield Wizard.

The Spire CX260 software is installed and the system restarts.

Note:  Your Remote Desktop Connection session is terminated during the restart process.

Note:  Do not manually delete any of the system resources before installing the new 
version. The installation process makes sure the upgrade is performed correctly. Manual 
deletion can cause unexpected system behavior.
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Installing the Spire CX260 With Control Station Upgrade 
Kit

1. Select Start > Settings > Control Panel > Add or Remove Programs to remove 
the current Spire CX260 software.

2. Restart the Spire CX260.

3. Insert CD #2 (Spire Application software) into your CD-ROM or DVD-ROM 
drive, and locate the Setup.exe application file in the CX260_v2.0 CD folder.

4. Double click Setup.exe to launch the installation. 

The Spire CX260 software is installed and the system restarts.

Note:  Do not manually delete any of the system resources before installing the new 
version. The installation process makes sure the upgrade is preformed correctly. Manual 
deletion can cause unexpected system behavior.
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Key Features

General

Operating System Support
The Spire CX260 receives and processes files from the following client 
workstations: 

• Macintosh – running Mac® OS 9.x or later, Mac OS X (10.4 and later), and Intel 
Mac (on Macs running Intel Mac OS)

• Microsoft® Windows® – running 2000, 2000 Pro, XP, XP Professional x64 
Edition, and 2003

Note:  To ensure that the Spire CX260 printer driver software is successfully 
installed on the Windows XP 64-bit platform, you must install the Microsoft Visual 
C++ 2005 Redistributable Package (x64) package. Go to the following web site:

http://www.microsoft.com/downloads/details.aspx?familyid=90548130-4468-
4bbc-9673-d6acabd5d13b&displaylang=en 

• UNIX workstations and servers

Remote Tools

EZ Connect
The EZ Connect application enables you to view information about any Spire color 
server on your network.

You can:

• View the printer status—for example, the status of the connection, tray, cable, 
and power

• Refresh the printer status

• Search for jobs

• Access the Remote Workspace or Web Center

Note:  You can only access the Remote Workspace or search for jobs on a Spire color 
server that supports these features.

We recommend that you connect to no more than eight Spire color servers at one 
time. The more connections that you have will affect the performance of the Spire color 
servers, making them slower.

For more information about how to install and launch the EZ Connect, see Installing 
and Launching EZ Connect on page 28.

http://www.microsoft.com/downloads/details.aspx?familyid=90548130-4468-4bbc-9673-d6acabd5d13b&displaylang=en
http://www.microsoft.com/downloads/details.aspx?familyid=90548130-4468-4bbc-9673-d6acabd5d13b&displaylang=en
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Remote Workspace
The Remote Workspace application enables you to access any Spire color server 
from a client workstation over the network. Multiple client workstations can access 
a Spire color server at the same time using the Remote Workspace.

In the Remote Workspace window, you can:

• Import jobs

Note:  The default location for importing jobs is the client workstation.

• View and manage job queues 

• View printer information

• Set job parameters

• Perform tray alignment

• Perform Off-the-glass calibration

• Perform calibration using the Eye-One spectrophotometer connected to your 
client workstation

Note:  Calibration using the Eye-One spectrophotometer is only available for the Pro 
Basic and Pro Control Station configurations

For more information about performing calibration using the Eye-One 
spectrophotometer connected to your client workstation, see Performing Calibration 
Using the Eye-One Spectrophotometer From Your Client Workstation on page 31.

Scan to E-mail
This feature enables you to receive and distribute scanned jobs to one or more e-
mail addresses.

Important:  To make sure your outgoing mail service is enabled on the Spire CX260, 
verify that the anti-virus software rules allow for mailing. For example, in Mcafee 
VirusScan Console, under Access Protection Properties, on the Port Blocking tab, 
clear the Prevent mass mailing worms from sending mail check box and click OK.

To set Mail Service options:

1. In the Settings window, select Mail Service.

2. In the Outgoing mail server box, type your outgoing mail server. Usually, you 
can obtain this from your site administrator or IT department.

3. In the Attachment max size list, select the maximum size for scanned jobs that 
will be attached to an e-mail message.

Note:  The maximum size for an e-mail attachment is 10 MB

4. In the Administrator E-mail address box, type the e-mail address that will 
receive any returned e-mail messages.

5. Under Authentication level, select either Anonymous or Basic. If you select 
Basic, you will need to enter a user ID and password.
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Spire Web Services
From the Xerox DocuColor 242/252/260 printer/copier’s touch screen, you can use 
Spire Web Services to view jobs in the Spire CX260 Print and Process queues, view 
the calibration status of the printer, and perform Off-the-glass calibration.

For more information about how to access the Spire Web Services and perform off-
the-glass calibration, see Spire Web Services on page 35.

Spire Print Driver Software
The Spire CX260 Print Driver software enables you to view and set job parameters 
in the Job Parameters window from any application on your PC client workstation. 

The Print Driver software also enables you to see the Xerox DocuColor 242/252/
260 printer/copier configuration, monitor the printer status, and save a set of print 
parameters for reuse.

Note:  The job parameters available in the Print Driver software are the same as the job 
parameters on your Spire CX260.

For more information about how to use the Spire CX260 Print Driver software, see 
Using the Print Driver Software on page 32.
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Job Parameters Window

Print Settings Tab

Print Mode
Print Mode parameters enable you to print color separations or progressively add 
color.

Separations
Separations prints the job with color or grayscale separations. If you select color 
separations, each page in the job is printed separately in four colors: cyan, magenta, 
yellow, and black. If you select grayscale, each page in the job is printed separately 
four times in different shades of grayscale (K).

Progressive Printing
Progressive printing prints each page of the job four times in progressive color 
separations, enabling you to examine the results of progressively adding color 
passes to a job:

• Sheet 1 is printed in cyan.

• Sheet 2 is printed in cyan and magenta.

• Sheet 3 is printed in cyan, magenta, and yellow.

• Sheet 4 is printed in cyan, magenta, yellow, and black.
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Imposition Tab

Imposition Methods
The Imposition Method parameter specifies the method with which printed sheets 
are imposed.

The following options are available:

• None for no imposition (this is the default option). 

• The imposition parameters are unavailable and the Preview window does not 
display an image.

• Step & Repeat to print multiple copies of the same image on one sheet so that 
the sheet is filled to capacity. This method is used mainly for printing business 
cards.

• Step & Continue to print different pages of a job on one sheet so that the sheet 
is filled to capacity.

• Cut & Stack to print, cut, and stack jobs in the most efficient manner while 
preserving the original page order. A job’s pages, booklets, or books are sorted in 
a Z-shape. In other words, each stack of pages is sorted in consecutive order. 
When stacks are piled one on top of another, the entire job is already sorted up 
or down.

Note:  Note: If you select Cut & Stack, you cannot change settings on the 
Exceptions tab or define any exceptions.
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• Saddle Stitch to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached 
through stitching or stapling in the spine fold. The technique is usually used for 
printing brochures.

When using the saddle-stitch imposition method, you can select the sets per 
sheet. This option enables you to select how many sets of the job will print on 
one press sheet.

• Perfect Bound to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached by 
trimming the spine fold, roughening the edges of the gathered pages, and gluing 
them together. The technique is usually used for hardcover books.

The Preview Window

The Preview window enables you to view your imposition layout and settings. 

You can open the Preview window at any time and keep it open to check your 
imposition settings as you select them. The Preview window dynamically reflects 
any changes that you make.

To open the Preview window:

Click preview .

Note:  The Preview window is only available for the Pro Basic and Pro Control 
Station configurations.

Note:  The Preview window is not available if the Imposition method is set to 
None.
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In the Preview window, you can perform the following functions:

• Click Front  to view the front pages.

• Click Back  to view the back pages.

• Move between sheets by clicking the navigation arrows  

• Jump to a specific sheet by typing a number in the navigation box.

Gray arrows indicate the direction of the pages on the sheet. The sequence of pages 
is indicated by the page numbers.

If any parameters conflict, Imposition Conflict appears in red in the Preview 
window and also on the Imposition tab.

D2 Finishing Options
The Spire CX260 supports the D2 finisher (Light Production option on the Finishing 
tab in the Job Parameters window). The D2 finsher provides the following finishing 
options:

Output Tray Finishing option

Top Tray • Punch

• Z Fold Half Sheet

Stacker Tray • Offset

• Stapler

• Punch

• Z Fold Half Sheet

Booklet Maker Tray • Fold

• Fold & Staple

Tri-Fold Output Tray • C Fold

• Z Fold
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Workspace

Job Alerts Window
The Job Alerts window has been enhanced. In the Alerts window, you can choose to 
display: 

• Job alerts

• System alerts

• Both job and system alerts

When you select one or more jobs, any error messages that are generated during 
the workflow of those jobs are displayed in the Alerts window. 

If you choose to display system alerts, any time the system emits an error message, 
the message appears in the Alerts window.

To display the Alerts window:

From the View menu, select Alerts.

The Alerts window appears.

Note:  By default, new messages are shown at the top of the list. For each message, 
the origin of the message is indicated, and a task that will solve the problem is 
suggested.

To display job alerts:

1. Select the desired job(s).

2. In the Alerts window, click the Show job alerts  button.

To display system alerts:

In the Alerts window, click the Show system alerts  button.

Job alerts are associated with the specific job. When a job is deleted, the associated 
job alerts are also deleted and removed from the Alerts queue.
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Job Forwarding
Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Job forwarding enables you to forward jobs from one Spire CX260 to another and to 
balance the load between servers on your network. The following options are 
available:

• Send to storage—send a job to the Storage queue of the destination server

• Send to print—send a job to the Print queue on the destination server and then 
store the job in the Storage queue

Storage Management
In the Settings window, under Preferences, Storage Management enables you to 
select an automatic job deletion policy for the Storage window.

To set automatic job deletion:

1. In the Settings window, select Storage Management.

2. In the Automatic job deletion area, do one of the following:

• Select the number of days after which stored jobs are automatically deleted.

• Select the number of hours after which stored jobs are automatically 
deleted.

Protecting Spot Colors
Using the Spot Color Editor window, you can now define specific RGB or CYMK 
colors that you want to protect—for example, official logos or company colors—to 
help produce color fidelity and color consistency between devices.
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The following tabs are available in the Spot Color Editor window:

• Spot Editor

• Protect RGB

• Protect Gray

• Protect CMYK

Editing the Spot Color Dictionary.

To edit an existing PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window appears with the Spire CX260's entire collection 
of colors listed.

2. To find the color that you want to edit, do one of the following:

• Under Color, search for a particular color.

• Alternatively, from the Spot dictionary list, select the color dictionary that 
contains the color that you want to edit.

Note:  Spot colors—for example PANTONE—are not effected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.

Note:  When you are searching for a color, you can type the first letter of 
the first word in the search box. For example, if you are searching for “Cool 
Gray 4” and type c, the mouse pointer locates the first color in the list that 
begins with the letter c.

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress 
software.
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3. Select the desired spot color. 

The CMYK values for that spot color and a color preview appear in the right-
hand side of the Spot Color Editor window.

4. Change the CMYK values as desired.

5. Click Apply. 

The new spot color is added to the custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor window, click add .

The Spot Editor dialog box appears.

2. Type the new color name as it exists in the PostScript file. 

3. Adjust the CMYK values as required.

4. Click OK. 

The new color is added to the custom dictionary.

Protecting Specific Colors

Using the Spot Color Editor, you can protect specific colors—for example, official 
logos or company colors—to help produce color fidelity and color consistency 
between devices. When you define a specific color as an RGB or CMYK spot color 
and enter a fixed CMYK target for it, the Spire CX260 treats it as a spot color, 
protecting it accordingly.

Note:  Spot color names are case-sensitive. Ensure that the new name is 
identical to the name that appears in the DTP software.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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To define an RGB color as a spot color:

1. In the Spot Color Editor window, click the Protect RGB tab.

2. Click add .

3. In the Color name box, type a name for your color.

4. Type the RGB source values and the CMYK target values, or select a spot color 
from the Predefined Spot list.

5. Click Save.

Note:  The RGB spot workflow applies only to LW elements.
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6. On the Protect RGB tab, select the color.

The color information appears.

7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.

A similar procedure is performed to define gray and CMYK colors as spot colors.

Protecting Spot Colors in the Workflow
Once you have defined spot colors to protect, you need to indicate in the job 
workflow if one or more of these spot colors should be protected.

On the Color tab, under Spot workflow parameters, two check boxes have been 
added for protecting spot colors:

• Protect RGB colors: to retain RGB colors as defined

• Protect Gray colors: to retain gray colors as defined

• Protect CMYK colors: to retain CMYK colors as defined.

Note:  If you protect RGB or CMYK colors, all colors in the job with that specific 
combination will be protected. For example, a specific color combination used in 
a logo may align with a color used in an image in the job. The spot 
transformation affects the image color as well as that of the logo, sometimes to 
undesired results.
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Tips

This section provides tips on how to use the Spire CX260 software or deal with 
problems.

Printing on Tabs Using the Spire Tabs Plug-In for Acrobat

The Spire Tabs plug-in for Acrobat (version 7.0 or later) enables you to create and 
place tabs in your unprocessed (PDF or PostScript) jobs, manage the tab and text 
attributes, and save a set of attributes for future use.

Note:  When using the Spire Tabs plug-in to create tabs, it is not necessary to define 
exceptions on the Exceptions tab.

To create tabs:

1. In the Storage window, right-click your unprocessed job and select 
Job Preview&Editor.

The job opens in Acrobat software.

2. From the Plug-Ins menu, select Spire Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes tab.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Note:  The job must be a PDF or PostScript file.
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3. In the Tabs area, set the tab attributes.

4. In the Text area, set the attributes of the text on the tabs:

5. Click the Content tab.

6. In the Before Page column, click the first cell and type the number of the page 
that you want the tab to precede.

7. In the Text column, type the text for the tab.

The tab appears in the thumbnail area.

8. To add more tabs, repeat steps 6 and 7.

9. Click Apply to apply the tab settings to your document.

The Tabs Printing window closes, and the tabs that you added become part of 
the document.

10. From the Acrobat File menu, select Save.

11. In the Spire CX260, select the Mixed paper size document check box on the 
Paper Stock tab, under Mixed paper size parameters.

12. Process and print the job.

Turning On and Off
Note:  This section applies to the basic configuration only.

The shut down process can take a few minutes. If you need to restart the Spire 
CX260, wait until the Spire CX260 LED 1 turns amber (Spire CX260 is off) before 
turning on the Xerox DocuColor 242/252/260 printer/copier.

Set the Mode (CP/B) switch to define the configuration type of your Spire CX260. 
There are two available options:

• CP—Use this setting if your Spire CX260 is connected to a stand or if you have 
the Pro Basic configuration. (This enables the server to act as a standalone 
computer without the need to turn on or off via the printer.

Note:  If the setting is set to CP, turning on the Xerox DocuColor 242/252/260 
printer/copier does not turn on the Spire CX260. To turn on the Spire CX260, you 
need to push the green On/off button.

• B—Use this setting if your Spire CX260 is bustled to a Xerox DocuColor 242/
252/260 printer/copier

Note:  For the basic configuration, make sure that the Spire CX260 mode switch is set 
to B so that the Spire CX260 turns on when the Xerox DocuColor 242/252/260 
printer/copier is turned on.

Important:  You must turn off the Spire CX260 before changing the mode switch 
position.
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Configuring the Printer Trays
When you load a new media type, define the new parameters for the relevant tray 
on the Xerox DocuColor 242/252/260 printer/copier

Note:  For tray 5, media type settings on the Spire CX260 override the Xerox DocuColor 
242/252/260 printer/copier settings.

Held Jobs Policy
You can select the policy of held jobs under Settings > Print Queue Manager. Held 
jobs are jobs that are sent to print with missing resources—for example, the paper 
size, paper type, or finisher type do not match the resources available in the printer.

The Spire CX260 Print queue handles jobs that were sent to print with missing printer 
resources in one of the following ways: 

• Suspends the jobs in the queue until the missing resource is available, or the job 
parameter is changed. The job appears in the queue with a Frozen icon.

• Sends the job to the printer and displays an alert on the printer.

For the Basic configuration, the held jobs policy is to send jobs with missing 
resources to the Print queue. For the Control Station and Pro configurations, the held 
jobs policy is to suspend jobs with missing resources in the Print queue.

To change the held jobs policy:

1. From the Tools menu, select Settings.

2. In the Held Jobs Policy area, select Hold jobs with missing resources.

3. Select one of the following options:

• Bypass held jobs to bypass frozen jobs in the Print queue.

• Don't Bypass held jobs to stop the printing from the queue when a job is 
assigned a frozen status.

4. Clear the Hold jobs with missing resources check box to always send jobs to 
the printer.

Note:  In the Spire CX260 Basic configuration, under Settings > Printing Modes, the 
Print job to best finishing option available check box is selected by default. In the Pro 
configuration, this check box is not selected by default.

Printing Mixed Media Documents
When printing mixed media documents, you select the tray from which your special 
pages—that is, exceptions, inserts, admin page, cover pages, slip sheets, and so 
on—will be printed. The Spire CX260 prints the special pages using the paper stock 
attributes that are currently configured in the selected tray.
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Printing the Calibration Chart
Before you print your calibration chart, make sure that the desired paper stock is 
loaded and configured correctly (size, tray, and media type) on the Xerox DocuColor 
242/252/260 Printer/Copier.

Note:  The Spire CX260 does not submit the calibration chart until the Xerox 
DocuColor 242/252/260 printer/copier and Calibration Wizard settings match.

Manual Duplex Workflow
Jobs with heavy paper stocks cannot be duplex-printed automatically on the Xerox 
DocuColor 242/252/260 printer/copier.

To duplex-print your job on heavy paper, perform the following actions:

1. On the first print run, set the following parameters on the Job Parameters 
window Print Settings tab:

• Print range—Odd pages

• Delivery—Face Up, 1 to N

Note:  If you are printing the second print run from tray 5, set Delivery to Face Up 
and N to 1.

2. Print the job.

3. Take the printed pages from the output tray and load them in the input tray.

Note:  If the job contains an odd number of pages, do not to take the last page of the 
first print run. Add the page to the end of the job after the second print run is 
complete.

• Make sure the orientation is correct for the job (head-to-head or head-to-
toe).

• In trays 1-4, load the pages with the printed side face-up. In tray 5 (bypass 
tray) load the pages with the printed side face-down.

4. On the second run, set the following parameters on the Print Settings tab:

• Print range—Even pages

• Delivery—Face Up, N to 1

5. On the Paper Stock tab, set the Media Type to Side-2 printing.

6. Print the job.

For Head to toe printing, place your printouts right 
side up in the tray.

For Head to head printing, place your printouts 
upside down in the tray.
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UNIX Connectivity
The Windows Services For Unix (SFU) software package is the only Spire CX260-
certified UNIX connectivity tool. For optimal Unix connectivity, it is recommended 
only to use the Windows SFU package.

Printing Booklets Workflow
Refer to the Xerox DocuColor 242/252/260 Printer/Copier User Guide for the booklet 
maker limitations.If your job exceeds these limitations—for example, folding more 
than five sheets per booklet—the job prints to the top tray instead of the booklet 
maker.

Perform the following steps to print a letter-size booklet:

1. Import your job.

2. On the Print Settings tab, under the Delivery parameter, select Face up.

3. On the Paper stock tab, under Paper size parameters, select 11×17 SEF.

4. On the Imposition tab, select the following options:

Note:  For more informatin, see Imposition Tab on page 12.

• Under the Imposition method parameter, select Saddle Stitch.

• Under the Sizes parameter, in the Trim Size list, select 8.5×11, and then 
select the portrait button.

• Under the Template parameter set the values as follows:

• Layout—Custom

• Columns—2

• Rows—1

• Print Method—Duplex HTH.

• Binding—Left

• Select the Rotate 90 deg. check box

5. Click the preview button to make sure the pages fit on the sheet.

6. On the Finishing tab, under the Finisher parameter, set the values as follows:

• Module—Light Production

• Output Tray—Booklet Maker Tray

• Select the Staple check box.

7. Process and print the job.
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Printing With Perfect Bound Imposition
The Spire CX260 enables you to create a perfect bound imposed job. 

To produce an imposed job ready for perfect bound finishing, print the job to any 
tray except the booklet maker.

Note:  Selecting the booklet maker means that the job is finished as a booklet (nested), 
and not ready for perfect bound finishing (piled).

Printing With the D2 Finisher
Perform the following steps to print a letter-size job using the C Fold or Z Fold 
finisher option.

1. Import your job.

2. On the Print Settings tab, set the values as follows: 

• Print method—Duplex head to head

• Delivery—Face up

Tip:  If you have the Pro Basic or Pro Control Station configuration, you can use the 
Gallop parameter, setting the values as follows:

• In the Gallop options area, select Yes for the job to start printing while 
the rest of it is being RIPed.

• In the Print after box, type the desired number. For example, if you 
type 5, the printer will begin to print your job after 5 pages are 
processed.

Note:  In an actual production environment, you would only use the Gallop 
option for a job with many records, that is, a mass mailing.

3. Click the Finishing tab.

4. Select the Finisher parameter, and set the values as follows:

• For Module, select Light Production.

• For Output Tray, select Tri-Fold Output Tray.

• Select the C Fold or Z Fold option.

5. Click Save.

6. Process and print the job.

The Light Production finisher folds the letters in c-fold or z-fold format so that 
they are ready to mail.

Perform the following steps to print a left bind, A3 sheet as an insert for an A4 job, 
using the Z Fold Half Sheet finisher option.

1. On the Print Settings tab, set the values as follows: 

• Delivery—Face down

• Rotate—Rotate 180

2. Click the Paper Stock tab.
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3. In the Paper size parameters, from the Size list, select A3.

4. Click the Finishing tab.

5. Select the Finisher parameter, and set the values as follows:

• For Module, select Light Production.

• For Output Tray, select Top Tray or Stacker Tray.

• Select Z Fold Half Sheet.

6. Click Save.

7. Process and print the job.

Adjusting Tray Alignment Parameters
If you need to compensate for printer image skewing problems, in the Spire CX260 
select Tools > Tray Alignment and follow the wizard. This enables you to set image 
shift and rotate parameters per tray, as necessary.

Note:  Tray alignment is not available from Tray 5.

EZ Connect Search Options
When searching for a job in the EZ Connect Search job window, instead of typing the 
exact name of the job, you can type part of the name and use an asterix (*) to 
replace the missing letters. For example, you can type “*Let*” for a job named 
“8_Page_Letter_US”.

Configuring Automatic Logon on the Spire CX260 
Controller

When the Spire CX260 is added to domain environments, it is bound by the security 
rules set by the system administrator, disabling the automatic logon. On the Spire 
CX260 basic configuration, this means that when you restart the Xerox DocuColor 
242/252/260 printer/copier, the Spire CX260 will not log on until the user or 
system administrator opens the RDC connection and inserts the correct password. 
The Auto Logon utility fixes this problem.

Note:  If you want to revert to the original workgroup configuration, it is recommended 
to uninstall the Spire CX260, remove the Spire CX260 from the domain, and re-install the 
Spire CX260 in order to enable the default 'Operator' user. This enables the automatic 
logon.
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The Auto Logon utility should be used only after you have installed the Spire CX260 
on the Controller and configured on the domain. The utility can also be used in cases 
when the system administrator or user want to change the default password for the 
'Operator' user, in a non-domain configuration.

1. Download the AutoLogonDomain.exe from the D:\Utilities folder on the Spire 
CX260.

2. Double click the AutoLogonDomain.exe utility, and in the Domain Auto Login 
window, type in the required password.

3. Click OK to accept new changes.

4. Restart the computer in order to enable automatic logon.

Installing and Launching EZ Connect

Installing EZ Connect

To install EZ Connect on your client workstation:

1. In the D:Utilites/PC Utilities folder on the Spire CX260, locate the 
EZConnect_v1_0_Setup.exe file and copy it to your client workstation.

2. On your client workstation, double-click the EZConnect_v1_0_Setup.exe file.

After installation is complete, the EZ Connect application appears under Start > 
Programs > EZConnect > EZConnect Runner.

Using EZ Connect

To launch EZ Connect:

1. Go to Start > Programs > EZConnect.

2. Select EZConnect Runner.

The EZ Connect icon appears on the taskbar.
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3. Double-click the EZ Connect icon on the taskbar.

The EZ Connect window appears.

To add a new server to the EZ Connect window:

1. In the EZ Connect window, click the Settings button , and select Setup from 
the list.

The EZ Connect Setup window appears.

Tip:  The EZ Connect window can remain on your desktop while you are 
working in other software applications. If you close the EZ Connect 
window, the EZ Connect icon will remain on the taskbar.
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2. Click New.

The Add New Server window appears.

3. In the Hostname/IP box, type the server’s name or IP address.

4. In the Display Name box, type the server name that you want to appear in the 
EZ Connect window.

5. In the Type list, select the Spire color server type.

6. Click Connect.

The new server is displayed in the EZ Connect window.

7. Select the new server that you just added.

8. Click the Move Up or Move Down buttons to change the position of the server 
in the list, if desired.

9. From the Default Launch Application list, select the desired application 
(Remote Workspace or Web Viewer) that you will use to access the server.

10. From the Language list, select the desired language.

11. Select the Error Status Notification Sign check box to display a sign for errors.

Note:  The Remote Workspace application is only available for Spire color 
servers that support this feature.
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12. Click Save.

The server appears in the EZ Connect window.

Performing Calibration Using the Eye-One 
Spectrophotometer From Your Client Workstation

Note:  Calibration using the Eye-One spectrophotometer is only available for the Pro 
Basic and Pro Control Station configurations.

From your client workstation via the Remote Workspace, you can use the Eye-One 
spectrophotometer to create calibration tables.

To calibrate from your client workstation:

1. Install the EZ Connect application on your client workstation.

See Installing EZ Connect on page 28.

2. Add the desired Spire CX260 to the EZ Connect window.

See Using EZ Connect on page 28.

3. In the EZ Connect window, click the desired Spire CX260 to install the Remote 
Workspace.

The first time that you access the Remote Workspace application, the 
Downloading RWS dialog box appears.
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4. Click OK.

The following window appears.

The Logon dialog box appears.

5. Click Logon.

The Remote Workspace window appears.

6. Connect the Eye-One spectrophotometer to your client workstation.

7. Perform calibration using the Calibration wizard.

Note:  If the Eye-One spectrophotometer is not recognized on your client workstation, 
install the driver from the Spire CX260 Utilities folder (D:\Utilities\PC utilities\Eye-
One USB Driver).

Using the Print Driver Software
The Print Driver is automatically installed on the client workstation when you set up 
a network printer.

Note:  It is recommended that you use the Print Driver with SMB printers. For more 
information about how to define SMB printers, see the Creo Color Server 2.0 for the 
Xerox DocuColor 242/252/260 Printer/Copier Quick Connect Guide.

1. Open the file that you want to print—for example, a PDF file.

2. From the File menu, select Print.

3. In the Print dialog box, click Properties.

If this is the first time that you are using the Print Driver software, a message 
tells you that the software is loading. Then a dialog box appears with the print 
parameters.

Note:  The loading process might take a few minutes. Afterwards, accessing the 
Print Driver software takes less time.
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In the Print Driver software window, you can perform the following actions:

• Define job parameters

• Change parameters

• Lock a job

• Save a set of parameters

• Load a saved set of parameters

• Check the status of the Xerox DocuColor 242/252/260 printer/copier

• Define PostScript parameters for the job

Notes:

• Some of the job parameters in the Print Driver software appear in a different 
place from the Spire CX260.

• The Copies parameter value (located at the top of the Print Driver software 
window) reflects the number of copies that you selected in the Print dialog box 
of the software that you are currently working in.

Using the Spire Print Driver With an LPR Printer
Note:  If you want to use LPR printing, you need to define an LPR printer. For more 
information, see the Creo Color Server 2.0 for the Xerox DocuColor 242/252/260 
Printer/Copier Quick Connect Guide.
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When you work with an LPR printer, the status of the printer is offline. 

Note:  This does not prevent you from printing files to the Spire CX260.

To view the status of the printer online, perform the following steps when you add 
the LPR printer in the Add Printer wizard:

1. In the Name Your Printer box, delete the default printer name (AdobePS 
CX260_V2) and type the exact printer name from the Spire CX260 Virtual 
Printers list in the Resource Center—for example, CX260-1234_ProcessPrint.

2. Click Start and select Settings > Printers and Faxes (Windows XP) or Printers 
(Windows 2000, 2000 Pro, XP and 2003).

3. Select the LPR printer.

4. From the File menu, select Properties.

5. On the Print Driver tab, select Server Hostname, and type the IP address or 
server hostname.

6. Click OK.

The next time that you use the LPR printer, you will be able to connect to the Spire 
CX260 and the status of the printer will be online.
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Spire Web Services

To access Spire Web Services:

1. On the printer’s touch screen, touch All Services.

2. Touch Web Applications.
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The Spire Web Services window appears.

Performing Off-the-glass Calibration

To print the Off-the-glass calibration chart:

1. Do one of the following:

• From the Spire Web Services window, touch New Calibration.

• From the Calibration Status window, touch New Calibration.

The Print Calibration Chart window appears.
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2. Touch the button next to the desired tray and then touch Continue.

The following window appears.

3. In the Screening Method list, touch the arrow and select the screening method.

4. In the Gloss Enhanced list, touch the arrow and select Yes or No.

5. In the No. of copies list, touch the arrow and select the number of copies that 
you want to print.

6. Touch Print.

The Prepare for Scan window appears.

7. Touch Home to return to the Spire Web Services window.
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To calibrate the scanner and printer:

1. On the platen glass of the printer, place the KODAK Gray Scale calibration chart 
and the Off-the-glass calibration chart next to each other, facing down.

Notes:

• The KODAK Gray Scale calibration chart is in the Calibration Chart Kit 
envelope (part #518-00961A). Use only the KODAK Gray Scale calibration 
chart when calibrating the scanner and printer—do not use the Scanner 
Calibration chart, which is also in this envelope.

• If you place only the Gray Scale calibration chart on the platen glass, the 
printer is calibrated. If you place only the Off-the-glass chart on the platen 
glass, the scanner is calibrated. It is recommended that you place both the 
Off-the-glass and Gray Scale calibration charts on the platen glass at the 
same time so that you calibrate both the printer and scanner.

• If you need to calibrate a large paper size—for example, A3 or larger—cut 
the paper in order to fit the Off-the-glass and Gray Scale calibration charts 
on the platen glass

2. On the printer’s touch screen, touch All Services.

3. Touch Network Scanning.

4. On the General Settings tab, touch the 001 Calibration scan box.

5. Touch the Image Quality tab.

6. Touch the Standard Color Space button to select the specific color space of the 
Xerox DocuColor 242/252/260 printer/copier.

7. Touch the Device Color Space button.

8. Touch Save.

9. On the control panel, push Start to start scanning the charts.

The charts are scanned and measured and a calibration table is created.

If the calibration process is successful, two calibration tables are generated: 

• Normal—maintains the gray balance throughout the range of colors in the print 
job file

• Saturated—is the same as the normal table for 80% of the color range; but from 
that point on, each color has a greater density
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PPD for Macintosh OS X (10.4)
An additional PPD is available for Mac OS X (10.4) that does not check for any 
constraints between the selected printer options.

Notes:

• When working with the additional PPD all options are available, even if they 
conflict. If you select conflicting job options in the PPD, the job might freeze in 
the queue. Resolve the conflict by opening the Spire CX260 Job Parameters 
window and adjusting the options .

• If you use this PPD, check that the settings do not conflict with the Spire CX260 
options and the printer configuration before you send the job to print.

The additional PPD is available in the Spire Utlities folder in the specified Language 
folder (i.e. Utilities\PPD\English\MacOSX).

To use the additional PPD:

1. Copy the PPD to your Mac client workstation to the following path: 
Library > Printers > PPDs > Contents > Resources > en.lproj.

Note:  For PPDs in other languages, copy the PPD into the relevant language folder.

2. On the Macintosh, in the Printer Setup Utility, connect to the Spire CX260 and 
select the Network Printer.

3. Select the PPD you have copied.

The printer can be used from any DTP application.

FusionXZ Board Configuration Diagnostics
A diagnostic test that tests the FusionXZ board configuration is now available in 
cases where the dip switches are not set correctly on the Spire CX260.

When running the diagnostics on the FusionXD board, the following message may 
appear:

Fusion board configuration requires adjustments. Please call for 
service.

The user should contact a service representative to make the necessary 
adjustments on the FusionXD board or run diagnostic tests on the DFE.

Firmware Upgrade Utility
The Firmware Upgrade Utility enables you to upgrade your printer’s firmware via the 
Spire CX260 color server without the assistance of support personnel. Once the 
new firmware upgrade file is uploaded to the printer, the installation is performed 
automatically.
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To upload the firmware upgrade file:

1. Shut down the Spire CX260 color server application.

2. From the Start menu, select CX260 > CX260 Tools > Firmware Upgrade Utility.

3. Click Next.

The printer’s current firmware version information appears. 

4. Click Next to continue with the upgrade, or Cancel to abort. 

5. Select the required firmware file (*.pjl).

6. Click Next.

7. After the firmware file’s data analysis is complete, click Next.

The printer’s current and upgraded firmware version information appear. 

8. Compare the information. If your current version is identical to or more 
advanced than the proposed upgrade file, you do not have to proceed with the 
upgrade.

9. If you wish to proceed, click Upgrade.
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10. After the upgrade process is complete, click Next. 

11. Click Finish.
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Limitations

This section lists the limitations in the Spire CX260 version 2.0 software.

Remote Desktop Connection
The Spire CX260 uses Windows Remote Desktop Connection (RDC) utility for 
remote server administration. The Windows RDC is limited to a single connection 
session at a time.

Front and Back Covers
Front and back covers are not supported when printing using a print range. 

Only the original first and last pages of a job can be printed as front and back covers.

Scanner Calibration Chart
The Xerox DocuColor 242/252/260 printer/copier does not automatically 
recognize the Spire CX260 color server scanner calibration chart. Manually select a 
paper size bigger than the actual chart (that is, A4 or 8. 5x 11) on the Xerox 
DocuColor 242/252/260 printer/copier.

Printing Odd/Even VI Booklets
The Spire CX260 prints odd/even pages when the Odd/Even Booklets option is 
selected for a VI job.

IPX Setup Information
IPX setup information is not accessible via the Spire CX260.

Slow Startup After Installing New Software
The Spire CX260 takes approximately 30 seconds to turn on. However, when you 
turn on the Spire CX260 for the first time after installing new software, there can be 
a short delay of a few minutes.
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Calibration Error Message
If you select an empty tray in the Spire CX260 Calibration wizard, the Spire CX260 
issues the following message: 
“Load paper in tray <>”

Load paper in the empty tray, or select a different tray, and try again.

Changing the Default Archive Path
If you make changes to the default Spire CX260 archive path, restart the Spire 
CX260 application for the changes to take effect.

Z Fold Half Sheet Option and Small Paper Sizes
Do not use the Z Fold Half Sheet finishing option with a small paper size—for 
example, Letter or A4 paper sizes. Otherwise, this may cause a paper jam.

Exporting the Accounting Report
To export specific rows from the Accounting Report window, select the rows that 
you want to export, and then click Export. To export all rows, select all of the rows in 
the Accounting Report window and then click Export.

The Export button is inactive until you select the row(s) that you want to export.

Tray 5 and Tray Alignment 
Tray alignment is not supported for Tray 5.

Job Preview & Editor
DCS2 files that have been RIPed cannot be previewed in Acrobat using the Job 
Preview & Editor.

In the Job Preview & Editor, an A4 SEF job cannot be merged with an A3 job.

Spire Print Driver
The Spire Print Driver is only available for PC clients.

The only measurement unit available in the Spire Print Driver is inches.
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No Indication When Scan Cable is not Connected
There is no indication in the Spire CX260 color server if the scan cable is not 
connected.

Virtual Printers and Localization
When the language setting is French, you cannot create any virtual printers.

When the language setting is Russian, you cannot create a SpoolStore virtual printer.

Deleting and Importing Color Profiles
When you delete a color profile in the Resource Center, the associated device link 
(located in the D:\Color\DeviceLink folder) is not automatically deleted at the 
same time.

As a result, if you import a new color profile and name it the same name as the 
deleted color profile, the colors from the old profile are used.

Therefore, it is recommended that you always use a different name for imported 
color profiles.
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